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Technical Tutoring brings you this newsletter and training 
information in appreciation of your business and support 

Company News 
 

I don’t know where the time has 
gone because it doesn’t seem like 
enough has happened with the 
business to be doing another 
newsletter! 

 
 The one thing that I do 
know has happened in the office 
is that I’ve compiled a new 
textbook.  This one is on digital 
photography.  It gives 
suggestions on picking a camera, 
taking photos, editing your 
photos and then sharing and 
storing your digital photographs. 
 
 
 
 

Have you seen our web site? 

www.TechnicalTutoring.com 

A special thank you to Holly 
and Jackie who have now been 
running their offices of Technical 
Tutoring for over six months!  It 
seems amazing that so much time 
has passed since we first started 
talking about these additional 
locations!  And, of course, the offices 
wouldn’t be successful without the 
local people who responded to our 
offers of services. 

 
 
With Gratitude For You 

Always, 

Seema, Holly, & 

Jackie 
 

Technical 

  Tutoring 
  (508) 529-9087   

(508) 889-9112 or

   

  (781) 858-

6224 



Windows Update 
 

Well, it‟s still a year away, but we all know how quickly that time will pass.  The new 

version of Windows is now out for Developers to try.  It‟s now called Windows VISTA, due in 

stores in late 2006.  According to some, the new name goes with the new view the user is given 

with sharper graphics. 

As part of the new graphics, you will now see thumbnail (tiny) versions of your 

documents as the icons rather than a plain sheet of paper.  Folders will also start to visually 

display their contents – at least if there are more folders or just files.  In addition to better 

graphics, Vista has expanded to include context sensitive search windows everywhere it can. 

One article talked about a Microsoft Executive who synopsized the goals for Vista as 1) 

efficiency & reducing defects, 2) increasing confidence of the user community, and 3) improve 

the user experience. 

 Along with Windows Vista is being unveiled version 7.0 of Internet Explorer, said to run 

in a more „locked down‟ state to help with the many security issues that have been reported over 

the years. 

 Overall, the opinion of the first viewers of Vista is that there is a familiar surface with 

several changes on the inside that are meant to please developers. 

 

Office Update 
 

Not to be left behind it‟s companion software, Microsoft Office is also due for an upgrade in late 

2006.  This one professes to include new file formats (although the old ones will still be 

accepted) that use the XML tools from Office 2003.  There are also supposed to be additional 

ways to integrate the varying communication methods used today, including Instant Messaging, 

phones, e-mail and web portals.   One article I read indicated (and I find it hard to believe this 

came from anyone at Microsoft) that the new version will help users to make use of features and 

tools they didn‟t discover in previous versions of Office Products. Well, I‟m ready for that 

challenge, that‟s usually my typical reaction to the „new features‟ list of any Office release – just 

bringing forward things that were already there and few of us knew how to use. 



Software Tips 

 
EXCEL 
 To quickly double underline the 

contents of a cell, simply press the 

[Shift] key and hold it down then 

click the Underline button on the 

toolbar 

 In version 2002, you can add color 

by changing the background color of 

a sheet tab.  Right-click the sheet tab 

and choose Tab Color then pick from 

the palette and click OK 

 

POWERPOINT 
 Align multiple graphic items on a 

slide by selecting them as a group 

(use the Shift key) and then use 

ALIGN from the Draw menu. 

 Exporting your presentation to 

WORD is a quick way to create 

handouts or marketing materials. 

 

ACCESS 

 When you rearrange columns in 

Datasheet view, whether you save it 

or not, the order of the fields in 

Design view does not change.  To 

move columns in Datasheet view, 

select the column by clicking its 

heading then click the heading again 

and drag the column to your 

preferred location and release the 

mouse button. 

 

WORD 
 The PICTURE tab in the Format/ 

Picture dialog box allows you to set 

the color of the selected picture to 

WATERMARK.  This places a 

„faded‟ version of the picture on your 

page, which can then be moved to 

the back from the Draw menu. 

 In most Office programs, if you have 

multiple files open and want to close 

them all quickly, hold down the 

SHIFT key while clicking on the 

FILE menu.  The Close option will 

now say CLOSE ALL. 

 

OUTLOOK 

Your contacts become easier to work 

with if you understand there are different 

views available.  When looking at your 

contacts, use the VIEW menu and 

choose CURRENT VIEW.  You will see 

a list of several options for listing your 

contacts.  If you have several contacts at 

the same company, the BY COMPANY 

view might be useful.  Each unique 

company will be listed in its own gray 

bar with a plus or minus sign on the left.  

Click the plus sign to expand the listing 

and see everyone for that particular 

company 

 



Software Tips 

 
Microsoft Office 
Auto correct is a feature that is used by 

all components of Microsoft Office.  

This is the feature that causes the red 

squiggly lines thought to indicate a 

„typo‟.  What those red lines actually 

indicate is that the combination of 

characters you‟ve typed is not found in 

the current dictionary.  If the set of 

characters is accurate for your 

terminology, eliminate the lines now and 

in the future by adding the „word‟ to the 

dictionary!  Simply place the mouse over 

the characters with the red squiggle, 

click the right mouse button and choose 

Add from the pop-up menu.  That same 

set of characters should never again 

show up with a red squiggle!  As a 

bonus, you can add other items to 

AutoCorrect via the Tools menu.  For 

instance, if the name of your company or 

person you work for is long, you might 

consider adding an abbreviation to 

AutoCorrect so that every time you type 

the abbreviation, the system 

automatically expands your entry to the 

longer name or phrase.  For instance, 

I‟ve added „tt‟ to be replaced by 

Technical Tutoring, which saves me 16 

keystrokes every time I need to type the 

name of the company!  This is extremely 

beneficial when you realize that Word, 

Excel, PowerPoint, Access and Outlook 

use the same dictionary! 

 

 
 

The Internet 
I first learned of this new item through a 

creative Boy Scout in Troop 132 in 

Upton.   Now, my son has downloaded it 

to my machine and we‟re having fun 

exploring the world – Google Earth.  

This is a special search engine that looks 

through a list of satellite photos to bring 

you a view from space of your requested 

address anywhere in the world!  Not all 

the photos have the same quality 

resolution, but we‟ve had a lot of fun 

looking at our childhood homes, 

relatives‟ homes, or other sites from our 

past or our dreams – I hear the photos of 

the Grand Canyon are really terrific! 

The initial download is free, but there is 

a subscription service that includes more 

features for a fee, one of which allows 

you to provide satellite directions to your 

guests with lines you‟ve drawn to guide 

them. 

 

 

 

 
 

 
See our web site for additional 

software tips: 
 

www.TechnicalTutoring.com 
 



QuickBooks Features 
  
Well, it looks like it might be time for me to upgrade my QuickBooks software.  So, I went 

looking for what some of the new features are since my 2002 version.  Here‟s what I found: 

Added features in the PRO Version of QuickBooks: 

2003 2004 2005 2006 

Automatic budget 

creation 

Easier reconcile 

and undo 

reconciliation 

Print envelopes 

from forms 

Simplified Home 

Page 

Form 

customization 

options 

Email forms and 

reports as PDF‟s 

Print shipping 

labels for FedEx 

and UPS 

See account details 

and a complete 

transaction history 

for any customer 

or supplier in two 

mouse clicks or 

less 

Shipping Manager Manage loans Improved 

downloading of 

banking and credit 

card transactions 

Track Income and 

Expenses by Class 

Project cash flow State forms for 

payroll 

 

 

Sharing Outlook Amongst the Family 
 

If you have Windows XP, everyone in your family can use Outlook by setting up separate user 

accounts within Windows.  However, if you want to share a common calendar for family events, 

you should create a second Personal Folders file by choosing File/New/Outlook Data File.  It‟s 

best to store this in an area available to all users such as C:\Outlook.  Once created, you‟ll need 

to add folders for the type of data you plan to enter – right click on the top folder in the new set 

of Personal Folders, select New folder, and choose the data type (calendar, task, etc) from the 

box called “Folder Contains”  To make the shared folder available to all users (in Windows XP), 

you‟ll need to log in to each account and open the new folder by choosing File/Open/Outlook 

Data File.  Be aware that syncing with a handheld device will not update the new, shared file, 

only your personal file unless you purchase a separate software package. 

 

 



Troubleshoot Your Printer  USB 1.1 vs 2.0 
 

 

Here are some basic guidelines of things 

to check when your ink-jet printer just 

doesn‟t want to cooperate: 

 

 Connectivity –  

o Is it getting power? 

o Is the cable connected? 

 Applications – 

o Can you print from other 

software? 

 Status – 

o Is it paused? 

o Will a test page print? 

o Is it on-line? 

 Paper – 

o Loaded properly? 

o Check the print path 

o Check the feeder 

o Check the paper type 

o Check the paper weight 

o Is it overfilled? 

o Is the paper curvy? 

 Ink Blots – 

o Purge the ink cartridge 

o Clean the ink cartridge 

o Test the printer 

 Clogged Cartridge – 

o Force the ink out 

 Carriage – 

o Is it blocked? 

o Is it damaged? 

o Are ribbons/cables okay? 

 Print Quality – 

o Prime the cartridge(s) 

USB 1.1 and 2.0 connections 

are physically almost identical, but 

their speed differs significantly.  

USB 1.1 is the original version, 

while USB 2.0 arrived in 2004.  

USB 1.1 handles 12Mbps of 

throughput while USB 2.0 handles 

418Mbps, making it similar to fire 

Wire. 

You can connect a USB 2.0 

device to a USB 1.1 port without 

damaging the equipment, but making 

the device work properly on the 

slower port is another story.  This is 

especially true for devices that 

depend on the higher throughput for 

them to function, such as CD/DVD 

rewriteable external drives. 

 

FOOD FOR 

THOUGHT 

“The truth is that there is nothing 

noble in being superior to somebody 

else.  The only real nobility is in being 

superior to your former self.” 

Whitney Young 

Civil rights leader 

 
A true friend knows your weaknesses 

but shows you your strengths; feels 

your fears but fortifies your faith; sees 

your anxieties but frees your spirit; 

recognizes your disabilities but 

emphasizes your possibilities. 

William Arthur Ward 

Educator 



    The Options Dialog Box 
 

In any Microsoft Office 

application, if there is a good place to 

learn to explore, it‟s the Options Dialog 

Box.  This is the „control panel‟ for the 

particular software – Word, Excel, 

PowerPoint, etc. – and sometimes for 

features that are shared between the 

components of Office. 

 

The Options Dialog box is typically 

found by clicking on Tools / Options.  In 

here you can „flip switches‟ to turn 

features of the software on and off to 

meet your personal preferences.  Or, 

reset some of the factory settings to 

better meet your work habits. 

 

For instance, if you only have five 

spreadsheets that you ever use in Excel, 

wouldn‟t it be nice if they all showed up 

on the Recently Used Files list?  In the 

Options Dialog Box, you can reset the 

number of files that appear in the 

Recently Used Files list to whatever 

suits your needs (5, in my example). 

 

This is also the dialog box where you 

can reset the default location for storing 

your files – change it from My 

Documents to a network drive, or a 

specific folder within My Documents, as 

you see fit. 

 

I typically suggest that you explore this 

area by trying out changes to a few 

features and keeping track of what you 

changed when.  If you change something 

and find that the results don‟t meet your 

needs, you can open Tools / Options 

again and change the setting back to it‟s 

original value. 

 

Some of the most common things to 

change for Word and Excel in the 

Options Dialog box are: 

 Number of Recently Used Files 

Default file locations 

Default font and size 

AutoCorrect handling of typos 

Tool tips 

Auto Complete 

Colors 

How to format 

How to edit 

How to print 

What to display 

Styles for documents 

Calculations 

 

Take control of your work area and 

make these programs work the way you 

prefer by exploring and changing Tools / 

Options! 

 

 

 



 
 

 
 

 
 

We are so fortunate to have the support of so many family and friends.  Not to 
mention the many clients who have become friends through our work together!  It is 

because of you that this business was started and on your behalf that we keep 
growing our knowledge base in order to share that knowledge with you, as you 
need it.  Please know that your circumstances are confidential with us, but your 

friendship and success will always be the public declaration of Technical Tutoring! 

 

Remember our 6th year special:  refer 2 people who take 2 

hours of class each and get 2 hours FREE! 


